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Έναρξη – Τερματισμός του MatLab 
 
Η έναρξη της λειτουργίας του MatLab εξαρτάται από το λειτουργικό σύστημα.  
 
Στα συστήματα UNIX πληκτρολογούμε στη προτροπή του συστήματος (%): matlab 
 
Στα συστήματα WINDOWS η έναρξη γίνεται: 

 από το εικονίδιο MatLab:    στην επιφάνεια εργασίας, 
 από το μενού:   Έναρξη > Όλα τα Προγράμματα > MATLAB, ή,   
 πληκτρολογώντας στη προτροπή του DOS (>): matlab. 

 
Το κύριο παράθυρο της εφαρμογής περιέχει πολλά επί μέρους παράθυρα. Για παράδειγμα, στην παρακάτω 
εικόνα βλέπουμε τέσσερα από αυτά: Το Command Window (Παράθυρο Εντολών ή CW χάριν συντομίας) 
είναι το βασικό παράθυρο όπου δίνουμε όλες τις εντολές και παίρνουμε τα αποτελέσματα, το Command 
History (Ιστορικό) περιέχει το ιστορικό των εντολών που δώσαμε, το Workspace (Περιοχή Εργασίας) 
περιέχει τα ονόματα και τις τιμές όλων των μεταβλητών που έχουμε χρησιμοποιήσει και το Current 
Directory παρουσιάζει τα περιεχόμενα του φακέλου μέσα στον οποίο αναπτύσσουμε την εφαρμογή μας. 
Υπάρχουν και άλλα βοηθητικά παράθυρα, π.χ., για τις γραφικές παραστάσεις, για την εμφάνιση των πινάκων, ο 
editor των προγραμμάτων, κ.ά., τα οποία θα παρουσιάσουμε παρακάτω.  
 

 
 
Όταν το MatLab ξεκινά έχει σαν αρχικό φάσκελο εργασίας τον c:\matlab\work, και, εφόσον υπάρχει εκεί, 
εκτελεί το αρχείο startup.m. Αν δεν υπάρχει θα ελέγξει και στο φάκελο c:\matlab\toolbox\local. Με αυτό 
τον τρόπο το MatLab μας δίνει τη δυνατότητα να ρυθμίσουμε την εκκίνηση του, τοποθετώντας στο αρχείο 
startup.m τις εντολές που επιθυμούμε να εκτελούνται πρώτες. 
 
Ο τερματισμός της εφαρμογής MatLab γίνεται είτε από το μενού:   File > Exit MATLAB, ή,  δίνοντας στο 
Command Window την εντολή exit ή quit: 
  

>> exit  ↵ 
ή 

>> quit  ↵ 
 
Η εντολή exit τερματίζει αμέσως την εφαρμογή και ισοδυναμεί με το πλήκτρο Χ στην επάνω δεξιά γωνία του 
παράθυρου της εφαρμογής. 
 
Αντίθετα, η quit είναι πιο σταδιακή καθώς εκτελεί πρώτα ένα αρχείο με εντολές τερματισμού, το finish.m, 
στο οποίο μπορούμε να τοποθετήσουμε εντολές οι οποίες, π.χ., αποθηκεύουν την περιοχή εργασίας μας με 
όλες τις τρέχουσες τιμές των μεταβλητών, κλείνουν τα ανοιχτά αρχεία, ολοκληρώνουν τα γραφικά, και γενικά 
εξασφαλίζουν την ομαλή συνέχεια της εργασίας μας την επόμενη φορά που θα χρησιμοποιήσουμε το MatLab. 
 
Ένας συχνός συνδυασμός των δύο αυτών αρχείων είναι, το μεν finish.m να έχει την εντολή save που 
αποθηκεύει όλες τις τρέχουσες μεταβλητές από τη μνήμη στο αρχείο matlab.mat, το δε startup.m να έχει 
την εντολή load η οποία φορτώνει το αρχείο matlab.mat στη μνήμη. 

Παράθυρο Εντολών
Περιοχή Εργασίας 

Ιστορικό 
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Βοήθεια & Πληροφορίες 
 
Για οποιαδήποτε βοήθεια ή διευκρίνιση το MatLab διαθέτει όλες τις απαραίτητες οδηγίες παραδείγματα και 
πληροφορίες κάτω από το μενού:  Help > MatLab Help (F1) 
 

 
 
Επίσης, στο Command Window η εντολή help μας δίνει σαν απάντηση μια λίστα με όλες τις διαθέσιμες 
εντολές της εφαρμογής.: 
 

>> help  ↵ 
HELP topics 
 
matlab\general       -  General purpose commands. 
matlab\ops           -  Operators and special characters. 
matlab\lang          -  Programming language constructs. 
matlab\elmat         -  Elementary matrices and matrix manipulation. 
matlab\elfun         -  Elementary math functions. 
matlab\specfun       -  Specialized math functions. 
matlab\matfun        -  Matrix functions - numerical linear algebra. 
… … …  

 
Για να ζητήσουμε βοήθεια για μια συγκεκριμένη εντολή γράφουμε το όνομά της αμέσως μετά την εντολή 
help: 
 

>> help exit  ↵ 
EXIT   Exit from MATLAB. 
    EXIT terminates MATLAB. 
  
    See also quit. 

 
To MatLab διαθέτει επιπλέον πολλά παραδείγματα ή εφαρμογές για κάθε κατηγορία προβλήματος τα οποία 
είναι προσβάσιμα από το μενού: Help > Demos, ή,  από το Command Window με την εντολή demo: 
 

>> demo  ↵ 
 

 

Βασική Χρήση του Command Window 
 
Η πραγματοποίηση απλών υπολογισμών στο MatLab είναι πολύ εύκολη. Το CW λειτουργεί σαν μεταφραστής 
(Interpreter) που μετατρέπει κάθε μας εντολή σε γλώσσα μηχανής, την εκτελεί, και γράφει το αποτέλεσμα 
αμέσως κάτω από την εντολή. 
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Οι Βασικές Πράξεις (+), (-), (*), (/) & (^) και Σύμβολα  (…), (,) & (;) 
 
Οι πράξεις με αριθμούς γράφονται όπως σε οποιαδήποτε άλλη γλώσσα προγραμματισμού και εκτελούνται 
άμεσα. Το αποτέλεσμα (ans =) δίνεται ακριβώς κάτω από την εντολή. 
 

>> 2+3*5^2  ↵ 
ans = 
    77 

 
Η σειρά εκτέλεσης των πράξεων είναι η ίδια με όλες τις γλώσσες προγραμματισμού, δηλαδή,  πρώτα γίνεται 
η ύψωση σε δύναμη (^), μετά οι πολλαπλασιασμοί (*) και οι διαιρέσεις (/), και τέλος, οι προσθέσεις (+) και οι 
αφαιρέσεις (-). Η σειρά μπορεί φυσικά να αλλάξει με τη χρήση παρενθέσεων οι οποίες υπολογίζονται 
αρχίζοντας πρώτα από τη πιο εσωτερική. 
 

Για παράδειγμα η παράσταση:  
( )

2
343 61.33 1 10

11.2 2 3 / 4
⎛ ⎞−
⋅ + ⋅⎜ ⎟⎜ ⎟⋅ +⎝ ⎠

,  δίνεται ως εξής: 

  
>> 1.33*(1+(43-6^2)/(11.2*(2+3/4)))*10^3  ↵ 
ans = 
  1.6323e+003 

 
Στη περίπτωση που πληκτρολογήσαμε κάτι λάθος δεν χρειάζεται να ξαναδώσουμε ολόκληρη την εντολή. 
Χρησιμοποιώντας τα κατακόρυφα βέλη του πληκτρολογίου (↑↓) επιλέγουμε την εντολή με το λάθος και στη 
συνέχεια, με τα οριζόντια βέλη του πληκτρολογίου (← →) μετακινούμαστε στο σημείο του λάθους και το 
διορθώνουμε.  
 
Αν μια εντολή δεν χωράει σε μια γραμμή, μπορεί να συνεχιστεί στις επόμενες, εφόσον στο τέλος κάθε 
γραμμής τοποθετηθούν αποσιωπητικά (…). 
 

>> 1.33*(1+(43-6^2)/ ...  ↵ 
(11.2*(2+3/4)))*10^3      ↵ 
ans = 
  1.6323e+003 

 
Κάθε γραμμή μπορεί να περιέχει περισσότερες από μία εντολές, εφόσον αυτές διαχωρίζονται μεταξύ τους με 
κόμμα (,).   
 

>> 2+3, 4^2  ↵ 
ans = 
     5 
ans = 
    16 

 
Σε κάθε εντολή που δίνουμε στο CW, το MatLab απαντά με το αποτέλεσμα της. Αυτό όμως δεν είναι πάντοτε 
επιθυμητό, ειδικά για ενδιάμεσους υπολογισμούς. Η απάντηση του MatLab (έξοδος)  μπορεί να 
απενεργοποιηθεί με τη τοποθέτηση ενός ερωτηματικού (semicolon) (;) στο τέλος κάθε εντολής. Στη 
περίπτωση αυτή, παρόλο που δεν βλέπουμε το αποτέλεσμα, αυτό αποθηκεύεται και μπορεί να χρησιμοποιηθεί 
στη συνέχεια των υπολογισμών. 
 

>> 1.33*(1+(43-6^2)/(11.2*(2+3/4)))*10^3;  ↵ 
… … …  
>> ans  ↵ 
ans = 
  1.6323e+003 

 

Οι Μεταβλητές 
 
Στους απλούς υπολογιστές χειρός (calculators) τα αποτελέσματα κάθε πράξης εμφανίζονται στην οθόνη, όταν 
δε πραγματοποιήσουμε την επόμενή μας πράξη τα προηγούμενα αποτελέσματα διαγράφονται και τη θέση 
τους παίρνει το νέο αποτέλεσμα.  
 
Αυτό δεν συμβαίνει στις γλώσσες προγραμματισμού και στο MatLab. Εδώ τα αποτελέσματα των πράξεων ή 
των εντολών πρέπει να αποθηκεύονται στη μνήμη της περιοχής εργασίας μας, το κάθε ένα με το δικό του 
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όνομα, ώστε αργότερα να μπορούν να ανακληθούν. Τα ονόματα αυτά, τα οποία αναφέρονται σε θέσεις 
μνήμης της περιοχής εργασίας και περιέχουν τιμές και αποτελέσματα, λέγονται μεταβλητές. 
 
Τα ονόματα των μεταβλητών αποτελούνται από τα Λατινικά γράμματα (a-z, A-Z), τους Αριθμούς (0-9) και 
το σύμβολο ( _ ). Το μέγιστο μήκος των ονομάτων είναι 63 χαρακτήρες και δεν πρέπει να συμπίπτουν με 
δεσμευμένες λέξεις ή εντολές του MatLab. 
 
Στο MatLab τα κεφαλαία γράμματα διακρίνονται από τα αντίστοιχα πεζά (case sensitive). Δηλαδή, το “y” 
και το “Y” είναι διαφορετικές μεταβλητές και έχουν διαφορετικές τιμές.  
 
Η εκχώριση τιμών στις μεταβλητές γίνεται με το σύμβολο ίσον (=). Αριστερά του τοποθετείται το όνομα της 
μεταβλητής και δεξιά του η αλγεβρική παράσταση. Μόνο ένα όνομα μεταβλητής επιτρέπεται σε κάθε ανάθεση. 
Π.χ.: 
 

>> imax = 10;  ↵ 
>> xronos = 0.0;  ↵ 
>> embado_trigwnou = 0.5 * basi * ypsos;  ↵ 
>> A3 = 3.0;  ↵  

 
Οι μεταβλητές του MatLab δεν χρειάζονται ειδικές δηλώσεις, όπως στις γλώσσες προγραμματισμού, αλλά 
δημιουργούνται αυτόματα στη περιοχή εργασίας (Workspace) μόλις τους γίνει η πρώτη ανάθεση τιμής. 
 
Για να γράψουμε μια σύνθετη παράσταση μπορούμε να χρησιμοποιήσουμε και περισσότερες από μια 
ενδιάμεσες μεταβλητές. Όπως για παράδειγμα, η παρακάτω συνάρτηση μπορεί να γραφτεί: 

3 2

2

3 7
0.5 4.5

x x xf
x x
− + −

=
+ −

    για  x = 5, 

 
>> x = 5;  ↵ 
>> arithmitis = x^3-3*x^2+x-7;  ↵ 
>> paronomastis = x^2+0.5*x-4.5;  ↵ 
>> f = arithmitis / paronomastis  ↵ 
f = 
    2.0870 

Πίνακες και Διανύσματα (Μητρώα) 
 
Για να ορίσουμε ένα πίνακα στο MatLab χρησιμοποιούμε τις αγκύλες [ ]. Τα στοιχεία του πίνακα που 
βρίσκονται στην ίδια γραμμή τα χωρίζουμε με κενά, και τις γραμμές τις χωρίζουμε μεταξύ τους με το 
ερωτηματικό (;). Π.χ.: 
 

>> A = [ 1 2 3 ; 4 5 6]  ↵      ( Πίνακας 2x3 ) 
A = 
     1     2     3 
     4     5     6 
>> B = [ 1 2 3   ↵        ( Πίνακας 
3x3 
4 5 6            ↵          αντί 
του ; 
7 8 9]           ↵          δίνουμε 
Enter ) 
B = 
     1     2     3 
     4     5     6 
     7     8     9 
>> C = [1 2 3 4]  ↵        ( 
Διάνυσμα 1x4 ) 
C = 
     1     2     3     4 
>> D = [1; 2; 3; 4]  ↵       ( 
Διάνυσμα 4x1 ) 
D = 
     1 
     2 
     3 
     4 
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Για να αναφερθούμε σε ένα συγκεκριμένο στοιχείο ενός πίνακα γράφουμε το όνομα του πίνακα και αμέσως 
μετά σε παρένθεση ( ) γράφουμε τους δείκτες που ορίζουν τη θέση του στοιχείου που θέλουμε. Οι δείκτες 
είναι τόσοι όσες και οι διαστάσεις του πίνακα. Π.χ. 
 

>> A(2,2), B(3,2)  ↵ 
ans = 
     5 
ans = 
     8 

 
Μπορούμε επίσης να πάρουμε ένα απόσπασμα ενός πίνακα επιλέγοντας μια περιοχή του πίνακα. Στη θέση 
κάθε δείκτη βάζουμε την περιοχή τιμών του, δηλ., την αρχική τιμή μια άνω κάτω τελεία (:) και τη τελική τιμή, 
ορίζοντας έτσι τη περιοχή του πίνακα που επιθυμούμε. Π.χ.:  
 

>> B1 = B(1:2,2:3)  ↵ 
B1 = 
     2     3 
     5     6 

 
Τέλος μπορούμε να κατασκευάσουμε μεγάλους πίνακες από άλλους μικρότερους, ή από μείγμα πινάκων και 
στοιχείων. Π.χ.:  
 

>> E = [ B; 10 11 12; 13 14 15]  ↵ 
E = 
     1     2     3 
     4     5     6 
     7     8     9 
    10    11    12 
    13    14    15 
>> F = [B B]  ↵ 
F = 
     1     2     3     1     2     3 
     4     5     6     4     5     6 
     7     8     9     7     8     9 

 

Γραφικές Παραστάσεις 
 
Τα αποτελέσματα των εργασιών μας σχεδόν πάντα περιέχουν διαγράμματα ή γραφικές παραστάσεις. Οι 
γραφικές παραστάσεις είναι επίσης ο καλύτερος τρόπος να παρουσιάσει κανείς μεγάλο αριθμό αποτελεσμάτων 
και να εξάγει γενικά συμπεράσματα που δεν είναι προφανή από τους αριθμούς και μόνο. 
 
Το MatLab διαθέτει ένα μεγάλο αριθμό ευέλικτων εντολών για τη δημιουργία γραφικών που καλύπτουν όλες 
τις ανάγκες του χρήστη, από τα απλά και γρήγορα γραφικά για ένα εργαστηριακό φύλλο έργου, μέχρι τα 
γραφικά με τις ειδικές προδιαγραφές που δημοσιεύονται σε διεθνή επιστημονικά περιοδικά. 
 
Οι πιο συνηθισμένες εντολές για να δημιουργηθεί ένα γραφικό περιέχονται στον πίνακα που ακολουθεί: 
 

Εντολή Ερμηνεία 
plot(x,y) σχεδιάζει το  y  vs  x (διανύσματα ή πίνακες) 
plot(x,y1,x,y2,x,y3) σχεδιάζει τα  y1, y2 & y3  vs  x  στο ίδιο γραφικό 
xlabel('X label') βάζει ετικέτα στον άξονα των Χ 
ylabel('Y label') βάζει ετικέτα στον άξονα των Υ 
title ('Title') βάζει τίτλο επάνω από το γραφικό 
grid προσθέτει ένα πλέγμα κάθετων & οριζόντιων γραμμών 
gtext('Text') προσθέτει όποιο κείμενο θέλουμε στο σημείο που θα 

δείξουμε με το ποντίκι. 
ezplot('sin(x)') σχεδιάζει συναρτήσεις από τον τύπο τους 

 
Τα δεδομένα x, y, κλπ., που θέλουμε να σχεδιάσουμε έχουν συνήθως προκύψει από προηγούμενες εντολές ή 
από κάποιο αρχείο. Εδώ θα τα δημιουργήσουμε με δυο εντολές. Πρώτα δημιουργούμε το διάνυσμα Χ το 
οποίο αρχίζει από το -400 και με βήμα 1 φτάνει στο 400 και περιέχει 801 στοιχεία. Στη συνέχεια 
δημιουργούμε το Y δηλαδή τη συνάρτηση που θέλουμε να σχεδιάσουμε και η οποία είναι:  Y = ημ(Χ/100). 
Εφόσον το Χ είναι διάνυσμα, και το Y θα προκύψει διάνυσμα με το ίδιο μήκος. Τέλος δίνουμε την εντολή  
plot(X,Y) που σχεδιάζει το Y ως προς το Χ, και εμφανίζεται η γραφική παράσταση. 
 

>> x = -400:400 ;  y = sin(x/100);  ↵ 
>> plot(x,y)  ↵ 
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Στη συνέχεια θα δημιουργήσουμε μερικές ακόμα συναρτήσεις, θα τις σχεδιάσουμε όλες μαζί και θα 
προσθέσουμε πλέγμα, ετικέτες και τίτλους με τις εντολές που αναφέραμε στον προηγουμένο πίνακα. 
 

>> y1 = 0.5*sin(x/200) ; y2 = 0.7*sin(x/25);  ↵ 
>> plot(x,y,x,y1,x,y2)  ↵ 
>> grid  ↵ 
>> xlabel('Etiketa tou Axona X')  ↵ 
>> ylabel('Etiketa tou Axona Y')  ↵ 
>> title('Titlos Grafikis Parastasis')  ↵ 
>> gtext('y'), gtext('y1'), gtext('y2')  ↵ 

 

 
 
Για τις τρισδιάστατες (3-D) γραφικές  παραστάσεις, το MatLab διαθέτει ειδικές εντολές όπως είναι η mesh(), 
surf(), κ.ά., που σχεδιάζουν τα δεδομένα στους άξονες Χ-Υ-Ζ. Για παράδειγμα για να σχεδιάσουμε την 
συνάρτηση: z = x · exp( -x2 -y2 )  στο διάστημα  
-2 < x < 2 και -2 < y < 2  δίνουμε τις εντολές: 
 

>> [x,y] = meshgrid( -2:.1:2, -2:.1:2);  ↵ 
>> z = x .* exp( -x.^2 - y.^2);  ↵ 
>> mesh(z)  ↵ 

 

 
 
 


